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PRAKATA 

 

 

 
Alhamdulillah, setinggi-tinggi syukur ke hadrat Allah  s.w.t. kerana dengan limpah 
kurnia-Nya buku Cara Mudah Reka Bentuk Banner dengan Adobe Illustrator ini telah 
berjaya disempurnakan. Buku ini adalah cetusan daripada beberapa siri kursus asas 
Adobe Illustrator yang telah dilaksanakan di Kolej Komuniti Temerloh.      

Kandungan di dalam buku ini adalah  berasaskan kepada kandungan kursus 
pendek asas grafik dan reka bentuk  banner yang pernah digunakan oleh penulis  
dalam  menyampaikan kursus kepada peserta. Ia boleh dijadikan panduan oleh 
sesiapa sahaja yang ingin berjinak-jinak dalam bidang reka bentuk. Teknik asas 
yang diberikan bukan sahaja boleh digunakan untuk membuat banner malah 
boleh juga digunakan untuk sebarang reka bentuk lain seperti poster, kad, sijil dan 
sebagainya.  

Berdasarkan pengalaman penulis dalam mereka bentuk banner, teknik-teknik yang 
disampaikan dalam buku ini adalah asas yang perlu diketahui oleh seorang pereka 
bentuk grafik dalam menggunakan Adobe Illustrator. Bahasa yang  mudah dan 
santai diharap dapat memberikan kefahaman yang lebih kepada semua 
pembaca.  

Di kesempatan ini, penulis ingin mengucapkan jutaan terima kasih kepada keluarga 
yang sentiasa menyokong  dan memberikan kepercayaan kepada penulis dalam 
apa jua keadaan. Tidak dilupakan kepada semua rakan-rakan dan semua pihak 
yang tidak jemu memberikan galakan, nasihat dan tunjuk ajar untuk penulis  
meneruskan penulisan ini.  

Akhir kata, semoga buku ini dapat memberikan manfaat dan panduan kepada 
semua pembaca untuk berkarya dalam bidang grafik. 

Sekian, Terima Kasih.  

 

Kolej Komuniti Temerloh  
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1 Cara Mudah Reka Bentuk Banner Dengan Adobe Illustrator 

PENGENALAN 

 
ANDAKAH ANDA BERMINAT DALAM BIDANG REKA BENTUK GRAFIK?  

 

Jika jawapannya adalah ya, salah satu kemahiran yang anda perlu tahu adalah 
kemahiran menggunakan perisian Adobe Illustrator.   

 

APA ITU ADOBE ILLUSTRATOR?  
 

Adobe illustrator merupakan salah satu aplikasi 
perisian daripada Adobe. Perisian ini sangat popular bagi 
menyunting grafik jenis vektor. Ia mempunyai keupayaan 
untuk menghasilkan grafik dan ilustrasi bagi kegunaan 
digital seperti web dan video ataupun untuk cetakan. 
Pada hari ini, Illustrator sangat digemari oleh para pereka 
grafik kerana keupayaannya untuk menghasilkan 
pelbagai reka bentuk grafik yang menarik dan berkualiti.  

Grafik vektor merupakan imej lukisan atau imej 
yang berasaskan objek. Ia merujuk kepada sebarang imej yang dihasilkan dengan 
menggunakan teknologi komputer, menggunakan perisian-perisian tertentu dan 
diwakili dalam bentuk geometri (arahan matematik). Bentuk geometri boleh terdiri 
daripada garis lurus, oval,lengkungan, bulatan dan sebagainya. Grafik jenis ini boleh 
diubah saiz dalam skala besar tanpa menjejaskan resolusi imej tersebut. 

Imej atau gambar yang biasa kita lihat dikenali sebagai imej bitmap atau 
raster. Imej seperti ini mempunyai saiz atau resolusi yang tetap. Sekiranya ia 
dibesarkan, akan menjadi pecah atau ‘blur’.  Sebagai contoh, gambar yang 
diambil menggunakan telefon bimbit adalah imej raster. Saiznya bergantung 
kepada resolusi yang terdapat pada kamera. Jika gambar tersebut dibesarkan 
atau di ‘zoom’ pada skala yang tinggi, imej tersebut akan menjadi kabur atau 
‘pecah’. Rajah di bawah menunjukkan perbezaan antara imej vektor dah raster.  
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Di dalam edisi kali ini, anda akan didedahkan dengan sedikit teknik asas untuk 
penghasilan grafik, teks  dan menghasilkan e-banner dan juga banner untuk 
percetakan.  

 

BANNER DAN BUNTING 

 
Banner dan bunting atau kain rentang merupakan salah satu medium hebahan 
atau pengiklanan yang sangat popular. Kita boleh lihat banner di mana-mana 
sahaja sama ada digantung di jalanan, ataupun di dalam aplikasi pada peranti 
elektronik.  Selain mempromosikan perkhidmatan dan barang jualan, ia turut 
digunakan untuk menyampaikan maklumat mengenai sesuatu organisasi dan 
sebagainya. Contohnya, sekolah menggunakan banner untuk memaparkan 
maklumat untuk makluman pelajar dan ibu bapa. Perkara paling penting dalam 
penghasilan banner adalah kandungan dan reka bentuknya.  

Banner boleh dikategorikan kepada 2 iaitu e-banner atau banner yang bercetak. E-
banner adalah banner yang biasanya diletakkan di laman web. Ia adalah 
berbentuk digital, saiz bagi banner jenis ini kebiasaannya adalah lebih kecil dan 
sesuai untuk paparan digital.  
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APAKAH PERBEZAAN ANTARA BANNER DAN BUNTING?  

 

 
 
 
 
 
  

 

 

 

 

 

 

 

Banner 
• Saiz secara melintang. 

• Biasanya ukuran adalah lebih besar 
berbanding bunting 

 

Bunting 
• Saiz secara menegak. 

• Saiz lebih kecil berbanding banner 
• Selain diikat menggunakan tali, ia juga 

mempunyai kaki untuk digantung 
 

Contoh e-banner dalam laman 
web shopee.com.my 
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MEMULAKAN KERJA DENGAN ADOBE ILLUSTRATOR  
 

Adobe Illustrator telah mempunyai pelbagai versi dan sehingga kini, versi 
terkini adalah Adobe Illustrator CC 2020.  Walau bagaimanapun, untuk tutorial 
pada kali ini, kita akan menggunakan versi CC 2019. Jika anda masih baru dalam 
menggunakan perisian ini, jangan khuatir kerana peralatan (tool) dan asas 
penggunaan adalah hampir sama bagi semua versi.  

Untuk membuka perisian ini, anda perlu klik pada start dan pilih Adobe Illustrator  

 

Antaramuka seperti di bawah akan muncul.  

 

 

Create New >   

Tetingkap seperti di bawah akan muncul. Di sini, kita boleh membuat jenis tetapan 
dan saiz bagi artboard atau lembaran kerja yang ingin dihasilkan.  

Create New untuk membuka 
satu artwork yang baru 

Klik Open 
jika ingin 

membuka 
fail yang 

telah 
disimpan 

 

Pilihan saiz artboard 
yang boleh diambil 
jika sesuai dengan 

kerja yang ingin 
dihasilkan. Pilih 

Custom Size 
sekiranya 

mempunyai saiz 
yang tersendiri 
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Pengguna boleh memilih saiz yang telah disediakan oleh Ai 
ataupun memasukkan nilai saiz sendiri seperti yang 
diinginkan.  

Unit ukuran yang disediakan adalah seperti di dalam 
gambarajah ini. Pengguna boleh memilih unit ukuran yang 
paling sesuai dengan kehendak anda. Berhati-hati semasa 
memilih unit ukuran. 10 milimeters dan 10 inci adalah 
sangat berbeza saiznya. Oleh itu, pastikan anda memilih 
jenis ukuran yang tepat.  

 

 

 

 

Pilihan Ukuran artboard 
yang disediakan oleh Ai 

Pengguna boleh 
tetapkan saiz 

artboard sendiri di 
sini 
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Andaikan anda memilih saiz 800px untuk lebar dan 
800px untuk tinggi artboard. Nilai unit yang akan 
digunakan adalah pixel. Oleh itu, pastikan anda 
memasukkan nilai yang betul dan unit yang betul. Klik 
Create jika telah selesai. 

 

 

 

 

 

 

Seandainya anda ingin menukar saiz bagi artboard, anda hanya perlu klik pada 
Document Setup pada bahagian tepi kanan antaramuka anda seperti dalam 
gambarajah di bawah. 
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Selain itu, boleh klik pada File > Document Setup 

atau menggunakan shortcut key iaitu Alt+Ctrl+P 

 

 

Antaramuka seperti di bawah akan muncul  

 

 

 

 

Klik di sini untuk 
menukar saiz artboard 

Tukar unit di 
sini jika perlu 

Klik ok jika tidak perlu 
menukar saiz artboard 
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Antaramuka Kerja Adobe Illustrator 

 

 

 

 

  

 

 

 

  
 

Artboard – saiz bergantung 
kepada tetapan pengguna. 

Boleh diubah mengikut keperluan 

Menu untuk fungsi-fungsi 
yang boleh dipilih Ubah tetapan yang diinginkan 

pada bahagian ini. 
 

Tools – peralatan yang 
digunakan untuk 
menyunting grafik 

Tukar saiz 
artboard di sini 

Ubah orientasi 
artboard samada 

portrait atau landscape 
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TOOLS 
Merupakan peralatan yang digunakan untuk kerja-kerja suntingan. Kita perlu tahu 
fungsi bagi setiap tools untuk memudahkan proses suntingan.  

BIL NAMA FUNGSI TOOLS 

1 Selection Tool 
(v) 

Untuk memilih Objek , 
memindahkan objek dan 
menyalin (copy) objek (alt + 
tarik objek)   

2 Direct-
Selection Tool 
(A) 

Memilih objek dengan lebih 
teliti. Pengguna boleh pilih 
bahagian tertentu pada objek, 
dengan klik pada point   

 

 

3 Magic Wand 
Tool (Y) 

Memilih objek yang 
mempunyai atribut yang sama 
seperti warna, garis, gradient. 

  

4 Lasso Tool (Q) Memilih objek dengan 
menyekat objek, cuba untuk 
menyekat objek untuk blok 
penuh. 

 

5 Pen Tool (P) Melukis objek  

 

 

6 Add anchor 
point tool (+) 

Menambah titik pada objek 
berbentuk vector 

7 Delete 
anchor point 
tool (-) 

Menghapus titik atau anchor 
pada objek yang berbentuk 
vector 

8 Convert 
anchor point 
tool (Shift + C) 

Untuk mengubah suatu titik 
atau anchor ,ia membolehkan 
objek yang lurus menjadi 
lengkung  
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BIL NAMA FUNGSI TOOLS 

9  Type Tool (T) Memasukkan Teks 

 

10 Area type 
tool 

Memasukkan teks dalam 
sesuatu objek seperti bentuk 
bulat dan sebagainya. Klik 
sahaja pada objek untuk 
menaip di dalamnya. 

11 Type on a 
path tool 

Membuat text di suatu garis 
objek yang berbentuk vector 
sesuai lekukan garis tersebut . 
jadi jika garis tersebut 
berbentuk lingkaran text akan 
berbentuk lingkaran 

12 Vertical type 
tool 

 Membuat text secara vertical 

 

13 Vertical area 
type tool 

Membuat text di dalam suatu 
objek yang berbentuk vector 
dan text yang di hasilkan akan 
vertical 

 

14 Vertical Type 
on a path 
tool  

Membuat text vertical  di suatu 
garis objek yang berbentuk 
vector sesuai lekukan garis 
tersebut . jadi jika garis tersebut 
berbentuk lingkaran text akan 
berbentuk lingkaran namun 
text akan vertical 

15 Line segmen 
tool (/)  

Membuat garis lurus 

 

16 Arc tool Membuat garis melengkung 

17 Spiral tool  Membuat garis dengan 
beberapa lekukan seperti spiral 

18 Rectangular 
Grid tool 

Membuat garis berbentuk 
kotak  dan ditengah kotak itu 
ada kotak-kotak kecil 
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BIL NAMA FUNGSI TOOLS 

19 Polar Grid tool Polar grid tool berfungsi untuk 
membuat garis berbentuk 2 
lingkaran  

 

20 Rectangle 
tool (M) 

Membuat objek berbentuk 
kotak dengan sudut 90 darjah . 

 

21  Rounded 
Rectangle 
tool 

Membuat objek berbentuk 
kotak dengan sudut 
melengkung 

22  Ellipse tool (L) Membuat objek bujur 

23 Polygon tool Membuat objek dengan 
pelbagai segi. Klik pada 
artboard dan tetingkap seperti 
ini akan muncul. Masukkan 
jumlah segi yang diingini 

 

 

24  Star tool Melukis bintang. Jumlah bucu 
juga boleh ditambah dengan 
cara klik pada artboard dan 
tetingkap 
seperti ini 
akan 
muncul. 
Masukkan 
nilai yang 
diingini 

25 Flare tool Flare tool berfungsi untuk 
menggambarkan efek cahaya, 
letakkan gambar efek cahaya 
di belakang background 
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BIL NAMA FUNGSI TOOLS 

26 Paint brush 
tool (B) 

Bertindak seperti berus lukisan. 
Untuk melukis 

 
27 Blob brush 

tool(shift +B) 
Sama seperti paint brush. Tetapi 
setiap garisan yang dilukis akan 
bercantum 

28 Pencil tool (N) Seperti pensil untuk melukis 
objek 

 29 Smooth tool Untuk mengatur letak anchor 
pada garis yang sudah di 
bentuk  

30 Path eraser 
tool  

Untuk memadam garisan 

31 Eraser Tool 
(shift + E ) 

Untuk memadam objek secara 
manual 

 

32 Scissors tool 
(C) 

Memotong garisan 

33 Knife Memotong objek 

34 Rotate Tool 
R)    

Memutarkan objek   

 
35 Reflect Tool 

(O) 
Memutarkan objek secara 
reflek atau terbalikkan 
kedudukan seperti dalam 
cermin 

36 Scale Tool (S) Untuk mengubah saiz objek. Klik 
2 kali pada 
icon dan 
tetingkap 
akan 
muncul. 
Masukkan 
nilai yang 
diingini  

 

 



 

 

13 Cara Mudah Reka Bentuk Banner Dengan Adobe Illustrator 

BIL NAMA FUNGSI TOOLS 

37 Shear Tool Untuk mengubah objek 
menjadi condong. Klik 2 kali 
pada ikon untuk mengisi nilai 
yang diperlukan.   

38 Warp tool 
(Shift+R) 

Mengubah bentuk objek 
mengikut keinginan kita. Setiap 
tool mempunyai fungsi atau 
bentuk yang tersendiri.  

 

39  Mesh 
tool  (U) 

Berfungsi seperti gradient tetapi 
lebih memudahkan kita untuk 
meletakkan warna pada 
mana-mana bahagian pada 
objek dengan klik pada point 
yang diperlukan 

 

40 Gradient Tool 
(G) 

Untuk membuat warna gradasi 
pada objek berbentuk vector . 

 

41 Eyedropper 
tool (I) 

Untuk melihat komposisi warna , 
namun selain itu juga tool ini 
berfungsi untuk mengubah 
warna objek vector . Caranya 
klik objek yang akan diganti lalu 
klik pada warna objek yang 
akan di tiru 

 

42 Blend Tool 
(W),  

Mengubah atribut blending 
objek.  Klik 2 kali pada icon ini 
akan menampilkan menu Blend 
Options 

 

43 Hand Tool (H) Untuk mengheret kedudukan 
artboard  bagi memudahkan 
kita melihat paparan dengan 
lebih jelas  
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BIL NAMA FUNGSI TOOLS 

44 Zoom Tool (Z) Sebagai zoom untuk 
membesarkan atau 
mengecilkan paparan 

 

45 Fill / Stroke Fill – untuk warna objek 

Stroke – untuk warna garisan 
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SUNTINGAN TEXT 

 
Teks amat penting untuk menyampaikan maklumat. Untuk memasukkan teks, anda 

perlu klik pada tools  pada toolbox dan klik di atas artboard. Kemudian, terus 
taipkan perkataan yang diingini.  Seterusnya, untuk mengubah saiz dan stail tulisan, 
anda boleh memilih bahagian properties yang disediakan di sebelah atas dan 
kanan antaramuka. (Untuk paparan Essentials Classic. Bagi paparan Essentials, 
bahagian Properties hanyalah di sebelah kanan sahaja) 

 

 

Untuk membuat sebarang perubahan pada teks, pastikan anda klik terlebih dahulu 

tulisan tersebut menggunakan Selection Tool  pada bahagian Tool (Rujuk 
penerangan tentang Tools).  

 

 

 

 
 

 

 

 

Warna teks (Fill) 
 

Warna Garisan 
(Stroke) 

 
Kesan Transparent 

(Opacity) 
  

Menambah kesan 
khas lain pada teks 

(fx) 
 

jenis tulisan, saiz, jarak 
dan perenggan 
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Anda boleh menggunakan Warp options untuk memberikan gaya kepada teks 

 

 

 

Muat Turun Tulisan (FONT) 

Jika inginkan kelainan pada jenis tulisan, anda boleh mendapatkan beribu-ribu jenis 
tulisan lain yang disediakan samada secara percuma atau berbayar di internet. 
Anda hanya perlu mencari jenis tulisan yang anda inginkan di mana-mana enjin 
carian seperti Google.  
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Untuk contoh ini, boleh layari laman web https://www.1001freefonts.com/ 

Andaikan kita telah memilih jenis tulisan Junegull. Anda perlu klik pada download 
dan proses muat turun akan terus bermula 

 

 

 

 

Fail yg di muat turun biasanya yang telah dimampatkan. Oleh itu, kita perlu ‘extract’ 
fail terlebih dahulu dan kemudian simpan fail tersebut di dalam folder pilihan 
anda.Buka folder tersebut dan pilih fail font dalam format ttf. 

 

 

 

 

Jika kita google ‘free font’ 
terdapat banyak laman web yang 
menawarkannya. Anda boleh pilih 

mana-mana laman web yang 
disukai 

Click DOWNLOAD untuk muat turun  
 

Fail dengan format ttf.   
 

https://www.1001freefonts.com/
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Setelah selesai, cari nama tulisan 

 

 

Secara kebiasaannya, tulisan yang anda muat turun daripada laman web 
tidak sedia ada dalam komputer lain. Oleh yang demikian, sekiranya anda 
menggunakan tulisan tersebut untuk cetakan, pastikan komputer yang akan 
digunakan untuk mencetak mempunyai tulisan yang sama. Untuk lebih selamat, 
teks pada hasil kerja yang akan dicetak perlulah ditetapkan dengan ‘Create 
Outline’. Penjelasan dengan lebih lanjut akan diberikan pada tajuk yang terakhir 
nanti.  

 

Klik Install dan tulisan tersebut akan 
diinstall terus ke dalam komputer anda 

Nama Font yang baru di 
dalam senarai tulisan 
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SUNTINGAN GRAFIK 

 
Objek diperlukan untuk menghasilkan reka bentuk grafik pada banner. Pelbagai 
fungsi objek boleh diaplikasikan. Ia boleh dijadikan sebagai daya penarik atau latar 
belakang untuk text. Untuk melukis objek, kita boleh menggunakan pelbagai tools 
yang disediakan seperti  shape tools, brush tool, pen tool dan sebagainya. 
Penggunaan tools ini adalah mengikut kesesuaian reka bentuk yang diinginkan. 
Semua tools ada diterangkan pada bahagian Tools di atas. 

Untuk tutorial ini, kita akan melukis objek bulatan dan akan menghasilkan 3 kaedah 
mewarnakan objek. Sama seperti teks, tetapan bagi objek juga terletak di 
bahagian atas dan kanan antaramuka Ai.  

                                              

 

 

 

 

 

 

**tips: untuk melukis objek yang sekata saiznya, tekan butang shift pada keyboard 
dan tanpa dilepaskan, lukis objek anda.  

 

Shape Tools 
Jika mouse ditekan lama pada 

bahagian segitiga yang kecil ini, lebih 
banyak pilihan bagi bentuk-bentuk 

lain akan muncul 
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Kita boleh memilih kesan warna gradient untuk menghasilkan warna campuran 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ubah tetapan yang diinginkan pada 
bahagian ini. 

 

Fill – untuk mewarnakan bentuk  
 
Stroke – memberikan warna pada garisan : 
saiz adalah ketebalan stroke.  

Opacity – untuk memberikan nilai untuk 
objek dilihat lutsinar 

Pilihan warna untuk fill 
dan stroke 

 

 

Pilihan Gradient 
pada Fill  

 

Kotak putih berpalang ini 
bermaksud tiada warna 

 
Gradient pada 

Tools 
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Boleh ubah warna 
dengan klik pada 

slider 

 

Gradient  
 

Jenis gradient boleh diubah 
sama ada Linear, Radial 

atau Freeform  
 Linear 

Gradient  
 

Radial 
Gradient  

 

Freeform 
Gradient  

 

Untuk mengubah saiz objek adalah 
dengan klik pada objek dan letakkan 

tetikus pada salah satu kotak kecil yang 
terdapat pada sekeliling objek. Tarik objek 

tersebut mengikut saiz yang diingini 
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SUNTINGAN IMEJ 

 
Gabungan imej dan grafik boleh menjadi satu daya tarikan dalam penghasilan 
reka bentuk banner. Apa yang penting adalah daya kreativiti anda menggunakan 
peralatan dan fungsi-fungsi dalam Ai.  

Seperti yang anda sedia maklum, Ai bukan perisian yang digunakan untuk 
menyunting imej. Walau bagaimanapun, anda masih boleh menggunakan 
beberapa fungsi lain dalam perisian ini untuk memberikan kesan khas dan sedikit 
kelainan pada imej anda.  

 
MEMASUKKAN IMEJ 

 

Untuk memasukkan imej, perkara terpenting yang 
anda perlu ada adalah imej atau gambar.  

Pergi pada  File > Place.   

 

 

 

 

 

Kemudian browse di mana lokasi 
anda menyimpan imej tersebut 
disimpan, pilih imej dan klik Place 

 

 

 

 

 

 

Imej tersebut akan dimasukkan dalam Ai 
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CLIPPING MASK  

● Merupakan satu kaedah suntingan untuk menjadikan sesuatu objek sebagai 
topeng kepada satu objek yang lain.  

● Untuk tutorial ini, kita akan menjadikan satu objek bulatan sebagai topeng 
kepada sekeping gambar. 

● Langkah pertama adalah masukkan gambar yang diingini ke dalam Ai 
● Kemudian, lukis bulatan dan letakkan di atas gambar tersebut 

● Sekiranya objek anda berada di bahagian bawah gambar, langkah yang 
diperlukan hanyalah mengubah kedudukan gambar tersebut ke bahagian 
belakang. 
 

 
 

 

 

 
Klik kanan mouse dan pilih  

Make Clipping Mask 

Pastikan anda highlight 
kedua-dua objek 

Klik gambar dan klik kanan pada 
mouse > arrange > Send to Back  
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Contoh penggunaan Clipping Mask 

                          

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Objek bulatan dan imej telah digabungkan 
dan memberikan satu kelainan dalam 

paparan imej anda. 
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Teknik ini boleh juga boleh diaplikasikan pada teks.  

 

Untuk menyunting semula objek yang telah dikenakan Clipping Mask, Klik kanan 
pada mouse > Release Clipping Mask 
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MENYUNTING BANNER 
 

Seperti yang kita tahu, banner boleh digunakan untuk cetakan atau secara digital. 
Saiz bagi banner ini adalah berbeza. Untuk e-banner, saiznya adalah lebih kecil dan 
lebih mudah diukur dalam unit pixel. Tiada saiz yang tetap untuk e-banner ini dan ia 
bergantung kepada reka bentuk yang dihasilkan oleh pembangun laman web itu 
sendiri. Secara kebiasaanya, kita boleh menggunakan saiz seperti  960px X 320px  
atau 1000px X 300px dan sebagainya 

 

 

 

Banner yang bercetak biasanya mempunyai saiz yang lebih besar. Ia diukur dalam 
unit kaki. Di dalam Ai, saiz tersebut boleh ditetapkan dengan menggunakan unit 
inci.  

 

 

Oleh yang demikian, kita perlu mengubah nilai kaki kepada nilai inci apabila ingin 
menetapkan saiz artboard. Sebagai contoh, kita ingin menghasilkan banner 
dengan saiz 8 kaki x 4 kaki. Oleh yang demikian, tetapan saiz adalah seperti berikut: 

 

  

Saiz banner 
 

Unit ukuran dalam 
pixel 

Pilih mode RGB 
kerana warna 
tersebut lebih 
sesuai dengan 
paparan digital 

8 kaki X 12 inci = 96 inci  :  4 kaki X 12 inci = 48 inci 

1 kaki = 12 inci 
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Untuk tutorial kali ini, kita akan menghasilkan sebuah e-banner dengan saiz 960px X 
320px.  

Paling penting, kita perlu mempunyai idea dengan menjawab beberapa persoalan 
sepereti bagaimanakah reka bentuk banner yang akan dihasilkan? Apakah 
kandungan banner tersebut? Apa imej yang ingin dimasukkan? Apakah tema 
warna dan juga konsep latar belakang yang diinginkan? Persoalan ini terjawab 
dengan cara mendraf dahulu kandungan banner tersebut.  

 

 

 

 

 

 

 

 

 

Saiz banner 
 

Unit ukuran dalam 
inci 

Pilih mode CMYK 
kerana warna 
tersebut lebih 
sesuai untuk 

cetakan 

gambar 

logo 

Selamat Datang 
KOLEJ KOMUNITI 

TEMERLOH 
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Bagi mendapatkan idea untuk reka bentuk ini, kita boleh melihat contoh-contoh 
banner di internet.  

 

 

LANGKAH UNTUK MENGHASILKAN BANNER 

 

Langkah 1 

File > new  

Masukkan nilai width : 960px, height : 320px, units: pixels, Orientation: Landscape, 
color Mode: RGB Color dan tekan Create. 

Artboard anda akan muncul begini.  
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Untuk mendapatkan latar belakang yang menarik, terdapat banyak laman web 
yang menyediakan template yang boleh dimuat turun secara percuma dan 
berbayar.  Anda hanya perlu mencari template yang paling sesuai dengan reka 
bentuk anda. Antara contoh laman web tersebut adalah 

https://www.freepik.com/ 

Di dalam laman web ini, anda boleh mencari pelbagai jenis latarbelakang 
mengikut tema yang anda suka. Kata kunci yang boleh digunakan ialah seperti 
abstract background, nature background, technology, splash, puzzle, block, colorful 
background dan sebagainya. 

 

Langkah 2 

Pilih dan muat turun latar belakang banner anda.  

 

 

Masukkan kata kunci 
untuk carian di sini 

Klik pada free untuk 
template percuma 

Pilihan jenis fail yang 
diingini  

https://www.freepik.com/
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Jika anda telah mendapat reka bentuk yang diingini, klik pada gambar tersebut 
dan antaramuka seperti di bawah akan muncul. Klik pada Download

 

 

Klik Download  

Klik pada Free 
download  
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Fail tersebut adalah dalam folder yang telah dimampat dengan format zip.  

Setelah selesai, buka folder tempat simpanan fail anda. Nyahmampat (Extract)fail 
tersebut 

 

 

**format fail yang dimuat turun biasanya adalah pelbagai. Anda mungkin juga 
akan menerima fail dengan format .ai dan .epf. Jangan risau kerana fail tersebut 
dapat disunting menggunakan Ai.  

 

 

 

 

File tersebut akan terus di muat 
turun dan disimpan dalam folder 
Download dalam komputer anda 

atau dalam folder pilihan anda 

File yang telah siap 
dinyahmampat (extract) adalah 

dalam format eps.  
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Langkah 3 

Buka fail tadi di dalam Ai.  

Apa yang anda perlu tahu adalah saiz artboard pada fail ini adalah berbeza 
dengan fail yang ingin kita hasilkan. Oleh yang demikian, terdapat 2 cara di mana 
anda boleh dapatkan saiz fail yang diingini.  

1. Ubah saiz Artboard pada fail ini (Lihat pada tetapan Document Setup) 
2. Salin (copy) objek tersebut dan tampal (paste) pada dokumen yang telah 

dihasilkan tadi.  

Anda boleh memilih mana-mana kaedah yang sesuai. 

 

Langkah 4 

Sunting fail latar belakang tersebut mengikut reka bentuk yang diingini. 

Objek-objek pada reka bentuk ini biasanya telah di ‘Group’. Anda boleh ‘Ungroup’ 
untuk memudahkan kerja suntingan 
 
Untuk contoh ini, tulisan yang sedia ada akan dibuang. Setelah boleh ‘Ungroup’ 
padam tulisan yang sedia ada tersebut.  

 

Klik kanan pada 
mouse dan pilih 

Ungroup 
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Setiap reka bentuk 
mempunyai susun aturnya 
yang tersendiri. Objek pada 
fail ini terdiri daripada 
gabungan bentuk polygon 
dan corak tumpahan cat. 
Anda boleh gunakan 
kreativiti sendiri untuk 
mengubah warna dan 
sebagainya atau 
membiarkan sahaja warna 
yang asal 

 

 

 

 

Langkah 5 

Susun kandungan banner anda seperti yang telah dirancang. Untuk tutorial ini, kita 
akan mengubah objek tersebut menjadi paparan gambar menggunakan Teknik 
Clipping Mask yang telah ditunjukkan di atas.  

Objek yang telah 
ditukar warna 
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Memandangkan objek yang tersedia terdiri daripada gabungan 2 objek, maka kita 
akan menggabungkan objek tersebut menjadi 1.  

 

  

 

 

 

 

 

 

Klik kanan pada objek dan pilih Ungroup. 

Seterusnya Make Clipping Mask  

 

 

Pilih kedua-dua objek 
tersebut, klik Unite pada 

Pathfinder 

Hasilnya, objek telah 
digabungkan menjadi 1. 
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Langkah 5 

Masukkan logo. 

File > Place 

Pilih gambar logo dan klik Place. Susun logo pada kedudukan yang telah 
dirancang.  

 

 

 

Saiz imej boleh diubah ikut 
kesesuaian dan susun 

pada lokasi yang sesuai 

Boleh zoom atau 
selaraskan paparan 

mengikut kesesuaian di sini 
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Langkah 6 

Masukkan Teks 

 

Langkah 7 

Anda mungkin ingin memasukkan latar belakang yang berwarna pada bahagian 
yang berwarna putih. Cara yang paling mudah adalah dengan meletakkan bentuk 
empat segi dengan warna yang diingini.  

 

Jika objek berada pada bahagian atas, gunakan arahan Arrange > Send to Back 
untuk membawa objek ke bahagian paling belakang 
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Langkah 8 

Sesuaikan warna tulisan dengan warna latar belakang supaya ia kelihatan lebih 
menarik. 

** pastikan warna teks dan warna latar belakang adalah kontras. Ini bagi 
memastikan teks anda dapat dibaca dengan jelas.  

 

Langkah 9 

Banner kita telah hampir siap. Untuk menambahkan lagi kesan yang lebih menarik 
pada teks, boleh gunakan kesan bayang pada teks. 

 

  

Klik pada fx > Stylize > Drop 
Shadow 
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Tahniah. Anda telah berjaya menghasilkan satu banner.  

 

 

 

 

 

 

 

 

 

Tetapan untuk Drop Shadow.  
Tandakan pada Preview untuk 

memaparkan pilihan anda.  
Klik OK setelah selesai.  
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KAEDAH CETAKAN 
 

Fail untuk cetakan boleh dihantar kepada bahagian cetakan dengan pelbagai 
format. Samada format Ai sendiri, PDF ataupun jpeg. Walaubagaimanapun, kualiti 
cetakan dalam format Ai dan PDF adalah lebih baik berbanding jpeg. 

Anda boleh save hasil kerja seperti biasa untuk menghasilkan format ai. 

 

Cara Simpan Untuk Format Ai  

File > Save 

Pilih folder anda dan berikan nama yang sesuai pada fail 

 

Cara Simpan Untuk Format Pdf 

File > Save As 

Pilih folder anda dan berikan nama yang sesuai pada fail 

 

 

 

 

 

 

 

 

 

 

Pilih format pdf 
pada Save as type.  
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Cara Simpan Untuk Format grafik (jpeg, png, tif) 

File > Export > Save for Web (Legacy) 

 

 

 

 

 

 

 

 

 

 

Pilih format imej yang 
sesuai samada GIF, 

JPEG atau PNG  

Klik save setelah 
selesai  

Ubah saiz jika 
perlu  
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CREATE OUTLINE 
 

Font yang anda gunakan adakalanya tidak ada dalam komputer yang digunakan 
untuk mencetak banner anda. Jika ini berlaku, jenis tulisan yang digunakan akan 
berubah kepada font lain. Bagi mengelakkan sebarang masalah pada design 
anda, pastikan tulisan yang digunakan telah ditetapkan kepada outline.  

Teks yang telah disetkan sebagai Outline tidak boleh disunting semula. Oleh yang 
demikian, sebagai langkah keselamatan, lebih baik jika anda membuat salinan fail 
yang asal dan buat satu fail lagi untuk diberi kepada percetakan.  

 

Highlight pada teks anda > klik kanan > Create Outlines 

 

 

**ulang langkah yang sama pada semua teks yang ada pada banner. 

 

Setelah selesai melakukan proses ini, fail anda telah sedia untuk dicetak. Perlu 
diingat, saiz fail akan menjadi besar sekiranya anda mengenakan banyak kesan 
khas pada objek seperti bayang dan sebagainya.  
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PENUTUP 

 
Kerja mereka bentuk memerlukan kesabaran dan ketelitian bagi mendapat hasil 
yang berkualiti. Kreativiti adalah sangat penting dalam menghasilkan sesuatu reka 
bentuk yang menarik. Masih banyak lagi fungsi-fungsi dan kegunaan peralatan 
(tools) yang disediakan di dalam perisian ini yang dapat memberikan kesan yang 
lebih menarik pada reka bentuk anda. Untuk menjadi mahir dalam menggunakan 
perisian ini, anda perlu kerap menggunakannya. Kerja-kerja mereka bentuk juga 
akan menjadi mudah sekiranya kita dapat menguasai penggunaan peralatan ini.  

Diharap agar tutorial ini dapat memberikan manfaat kepada semua pembaca.  
Sekian, Terima kasih.  

 

 

 

 

 



 

 

 

 

 

  

uku ini merupakan tutorial yang menerangkan langkah-langkah mudah untuk 
menghasilkan sebuah reka bentuk banner. Langkah-langkah tersebut 
merangkumi kaedah suntingan elemen seperti teks dan grafik serta langkah 
untuk menghasilkan reka bentuk. Penulis turut berkongsi tips bagaimana untuk 

mendapatkan teks yang menarik serta cara untuk memperolehi latar belakang yang 
menarik bagi banner.  Perkongsian ini sedikit sebanyak dapat memberikan 
pendedahan kepada mereka yang masih baru dan berminat dengan kaedah 
suntingan grafik menggunakan Adobe Illustrator 

 

 

 

 

 

 

NORFADZILAH BINTI ISHAK merupakan seorang pensyarah program Sijil Teknologi Maklumat. 
Beliau telah berkhidmat selama 5 tahun di Kolej Komuniti Bentong dan sekarang sedang 
berkhidmat di Kolej Komuniti Temerloh selama tempoh 6 tahun. Selain mengajar secara 
sepenuh masa, beliau turut berkhidmat sebagai tenaga pengajar untuk program 
Pembelajaran Sepanjang Hayat yang dikhususkan kepada komuniti setempat.  

 

B 

Diterbitkan Oleh 
KOLEJ KOMUNITI TEMERLOH 
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